
Chapter 2 

Working with VMware Workstation Pro 

VMware Workstation 12 has a number of changes that differ from the previous Workstation 6.5 product 

used in the book. The following activities have been modified to work properly with the new VMware 

Workstation 12 product and should be used in place of the activities in the book. 

Activity 2-1: Performing an Unattended Installation of VMware Workstation 

Time Required: 10 minutes 

Objective: Use Microsoft Installer to perform an unattended installation of VMware Workstation. 

Requirements: Completion of Activity 1-2 

Description: Superior Technical College plans to install VMware Workstation on all IT Department computers. To make 

this process more efficient, you decide to use an unattended installation. In this activity, you practice using this method by 

using the unattended silent installation option. 

  

1. If necessary, log on to your Windows host as the local administrator or a user who’s a member of the local 

Administrators group. (Being a member of the Administrators group ensures that you have the rights to change system 

settings and install the VMware service.)  

2. Since the unattended installation process is command driven, you will need to open an administrative command window. 

Click Start, All Programs, Accessories and then right-click Command Prompt and select the Run as administrator 

option. If necessary enter the password for the administrator and click Yes in the User Account Control window.  

3. Change the default path to the location of the VMware Workstation file you downloaded in Activity 1-2.  For example, if 

you saved your VMware Workstation installation file in the C:\Downloads folder, enter the following command to 

change the default prompt to your Download path: 

  CD  \Downloads 

4. Enter the following command to start the silent unattended installation, substituting "x.y-###" with your version number 

and  build number and sssss-sssss-sssss-sssss with your serial number, if you have one. If you will be using the 30-day 

trial, omit the SERIALNUMBER paramenter. Press Enter and allow the installation process a few minutes to finish. You 

should then see the VMware Workstation icon appear on the desktop. 

vmware-workstation-full-12.x.y-###.exe /s /nsr /v EULAS_AGREED=1 ADDLOCAL=ALL 

SERIALNUMBER="sssss-sssss-sssss-ssssss"   

 

NOTE: Be sure to leave at least one space between each of the command options. 

 

5. (Since the installation process does not provide any dialog boxes, it is difficult to know when it has finished. The best 

way to know when the installation is complete is to monitor CPU usage until it remains under 10%. ) 

6. After installation is complete and the VMware Workstation icon is displayed on the desktop, close the command window 

and log off. You are now ready to check out the installation by performing the steps in Activity 2-2. 

  



Activity 2-2: Testing your VMware Installation 

Time Required: 10 minutes 

Objective: Verify your VMware Installation. 

Requirements: Completion of Activity 2-1 

Description: In this activity you verify that VMware Workstation installed correctly by checking on the license number and 

preference settings.  

 

1. If necessary, boot your Windows host computer and log on using your assigned user name and password. It is not 

necessary to a member of the local Administrators group.  

2. Double-click the VMware Workstation icon to display the Welcome to VMware Workstation dialog box. Enter your 

license or click the "I want to try VMware Workstation 12 for 30 days" radio button, enter your email address, click 

Continue, and then click Finish to display the VMware home screen. 

3. If you are using an evaluation license you will see the number of days left in your evaluation period. You can use the 

Help menu to enter a license key at a later time. 

4. From the VMware menu, click Edit and then click on the Preferences.. link to open the Preferences page. 

5. Click the Workspace option and verify the default location is set to C:\Users\username\Documents\Virtual Machines 

path. 

6. Click on the Devices option and verify that Auto run is disabled on the host computer. 

7. Click on the Shared VMs option and record the Shared location path and port number below: 

Path: _____________________________________________________________________ 

Port number: ________ 

8. Click Cancel to return to the VMware Workstation Home page without making any changes. 

9. Click File, Exit to close VMware Workstation console. 

10. Open control panel and use the Programs and Features option to remove VMware Workstation 12 from your Windows 

computer. When you see the Save the following VMware Workstation configurations message, be sure to remove the 

check marks from the Product license information and VMware Workstation configuration check boxes.  

  



Activity 2-3: Performing a Standard Installation of VMware Workstation 

Time Required: 15 minutes 

Objective: Perform a standard installation of VMware Workstation 12. 

Requirements: The VMware Workstation setup file you obtained in Chapter 1. 

Description: Assume that you are a technician for Computer Technology Training, and your manager, Lucas McMann has 

asked you to install and configure a Windows Server virtual server for use in the Superior Technical College data center. 

Lucas would like you to use VMware Workstation 12 as a workbench to install, configure, and test the virtual servers that 

will later be deployed in the college’s data center using VMware VSphere. In this activity, you perform a standard 

installation of VMware Workstation 12 in Windows. 

 
1. Log on to your Windows host as the local administrator or a user who’s a member of the local Administrators group. 

(Being a member of the Administrators group ensures that you have the rights to change system settings and install the 

VMware service.) 

2. In Windows Explorer, navigate to the folder containing the setup file you downloaded, and double-click the VMware-

workstation-full-11.#.exe file to start the installation wizard. (The # represents the installation file’s version and build 

number.) If Window’s User Account Control (UAC) message box opens, click Yes to continue. 

NOTE: If you are running the file from a network drive, you may receive a security warning message box. Click Run to 

continue. 

3. In the Welcome window, click Next to display the License Agreement page. Scroll down to review the license 

agreement and then click the I accept the terms in the license agreement radio button  to display the Setup Type 

window.  

4. You can select a typical or custom installation. For the purposes of this activity, verify click the Custom option button to 

display the VMware Workstation Features window.  

5. Leave the default features of Core Components, VIX Application Programming Interface and Visual Studio PlugIn. 

Notice that the Enhanced Keyboard option would need to be selected to support international keyboards.  Leave the 

default path of Program Files (x86)\VMware\VMware Workstation and then click Next to display the Workstation 

Server Component Configuration window. 

6. Record the path to the Shared VMs folder and the default HTTPS port and click Next to display the Software Updates 

window. 

Path: __________________________________________________________ 

7. Verify that the Check for product updates on startup option is selected and then click Next to display the User 

Experience Improvement Program window. 

8. Click to remove the check from the Help improve VMware Workstation check box and then click Next to display the 

Shortcuts window. 

9. Verify that the Desktop and Start Menu Programs folder are selected and then click Next to display the Ready to Perform 

the Requested Operations window. 

10. Click Continue to start the installation process. You have a few minutes to take a break while the file copying and 

installation take place. After the file copying is finished, the Enter License Key window will be displayed. 

 

NOTE: During the installation, if you see any Windows Security warning messages asking whether you want to install 

certain device software, such as the USB controller, click the option to install the software driver and continue the 

installation.  

 

  



11. If you have a license key, you may enter it at this time or click Skip to use a 30-day trial period. If you click Skip, you 

will also be given a chance to enter the key the first time you create or run a virtual machine.  

NOTE: You can also use the Help menu in the administrative console to enter the serial number (covered later in “Using the 

Administrative Console Menus”). 

 

12. After the License key page, the Setup Wizard Complete window will be displayed. Click the Finish button to close the 

window and return to the desktop. 

13. You have now successfully completed lab activity 2-3. You may either close VMware Workstation and log out of your 

computer, or leave VMware Workstation open for the next activity. 

  



Activity 2-4: Creating a Virtual Machine for Windows Server 2008 

Time Required: 10 minutes 

Objective: Create a virtual machine for a later installation of Windows Server 2016. 

Requirements: Completion of Activity 2-1  

Description: Now that you have installed VMware Workstation 12, your next task in developing and testing a server for the 

Superior Technical College is to create a Windows Server 2016 virtual machine that you can use to install and configure the 

new server environment. In this activity, you create a virtual machine that you will later use to install the Windows Server 

2016 guest OS. 

1. If necessary, log on to your workstation with your assigned username and password. 

2. Start VMware Workstation by using one of the installed shortcuts.  

3. Check the default document path to store virtual machines by clicking Edit, Preferences to display the Workspace 

window and verify that the default path is  C:\Users\username\Documents\Virtual Machines. Click OK to close the 

Preferences window. 

4. Click the Create a New Virtual Machine button from the Home tab to start the New Virtual Machine Wizard. 

5. In the Welcome window, click the Custom option button, and then click Next to display the Choose the Virtual Machine 

Hardware Compatibility window. 

6. In the Hardware compatibility list box, click Workstation 6. Notice that the Limitations section lists no SATA or EFI 

support and a 32GB memory limit. Click VMware Workstation 12 in the list box to change the setting back. Notice 

Workstation 12 has no limitations on SATA and that it supports 64 GB RAM and up to 16 virtual CPUs. Click Next to 

display the Guest Operating System Installation window. 

7. In the Guest Operating System Installation window, click the I will install the operating system later option button, and 

then click Next. 

8. In the Select a Guest Operating System window, click the Microsoft Windows option button, click the Version list 

arrow, and then click the Windows Server 2008 R2 x64.  Click Next to display the Name the Virtual Machine window. 

NOTE: The Windows Server you select in Step 9 should match the ISO file you downloaded in Chapter 1. 

9. By default, the virtual machine name matches the OS version, and the virtual machine folder is created in 

Documents\Virtual Machines. Change the virtual machine name to Windows Server 2008R2, record the path shown in 

the Location text box, and then click Next to display the Firmware window. 

 

__________________________________________________________________ 

 

 

10. Verify that the default BIOS firmware type is selected and then click Next to display the Processor Configuration 

window. 

11. In the Processor Configuration window, verify that one processor is selected and then click Next to display the Memory 

for Virtual Machine window. 

 

  



12. The Memory for the Virtual Machine window shows the minimum, recommended, and maximum memory for the OS 

you’re installing. If you have limited memory on your host computer and are planning to run multiple virtual machines at 

the same time, be sure the total memory doesn’t exceed the threshold in the Memory tab of the Preferences dialog box 

(explained later in “Using the Administrative Console Menus”) and then record the memory size you select below and 

click Next. 

_____________________________________________________________ 

 

NOTE: You can change the amount of memory later, as long as the virtual machine is stopped. 

 

13. In the Network Type window, verify that the Use network address translation (NAT) option is selected (unless your 

instructor specifies another option for your network environment), and then click Next. (You can change this option at 

any time, even while the virtual machine is running.) 

14. In the Select I/O Adapter Types window, make sure the LSI Logic SAS (Recommended) option button is selected, and 

then click Next. 

15. In the Select a Disk Type window, leave the default SCSI (Recommended) option button selected, and then click Next. 

16. In the Select a Disk window, make sure the Create a new virtual disk option button is selected, and then click Next. 

17. In the Specify Disk Capacity window, enter 100 in the Maximum disk space size (GB) text box, and verify that the Store 

virtual disk as a single file option is selected. Usually, you don’t want to allocate disk capacity now unless you’re 

installing a production server and performance is a major concern, so leave the default option selected, and then click 

Next. 

18. In the Specify Disk File window, verify that the name for the virtual disk file is the same as the virtual machine name 

entered in Step 10, with the .vmdk extension added. After verifying the filename and location, click Next to display a 

summary window. 

19. Verify your selections in the summary window click Finish. The virtual machine is then created, and the administrative 

console is displayed with a new tab for the virtual machine.  

20. You may leave VMware Workstation open for the next activity. 

  



Activity 2-5: Installing Ubuntu Linux with Easy Install 

Time Required: 20 minutes 

Objective: Perform an automated installation of Ubuntu Linux on a virtual machine. 

Requirements: Completion of Activity 2-3 and the Ubuntu Linux ISO image file (obtained from your instructor or 

downloaded from the Ubuntu Web site at www.ubuntu.com ) 

Description: Your company is looking at using a Linux server to host database and Web applications.  In this activity, you 

use VMware’s Easy Install feature to create a virtual machine running Ubuntu Linux. 

1. If necessary, log on to your workstation with your assigned username and password. 

2. Start VMware Workstation. If necessary, click the Home tab. Click the Create a New Virtual Machine button to start the 

New Virtual Machine Wizard. 

3. Click the Typical option button, and then click Next. 

4. In the Guest Operating System Installation window, click the Installer disc image file (iso) option button. Click the 

Browse button, navigate to the location of the ISO file, and double-click the file. Verify that VMware has detected the 

OS and shows that it will use Easy Install. Click Next. 

5. In the Easy Install Information window, enter your full name, username (must be all lowercase), and password to create 

the default Ubuntu user account, and then click Next. 

6. By default, the virtual machine name matches the OS version, and the virtual machine folder is created in 

Documents\Virtual Machines. Change the virtual machine name to UbuntuVM-iii (where iii represents your initials), and 

then click Next to display the Specify Disk Capacity window. 

7. In the Specify Disk Capacity window, accept the recommended disk size in the Maximum disk size (GB) text box, click 

the Store virtual disk as a single file option, and then click Next. 

8. Verify that the entries in the Ready to Create Virtual Machine summary window are correct verify that the Power on this 

virtual machine after creation option is selected. Click Finish to start.  

9. The virtual machine is then created, and the automated installation of Ubuntu Linux begins. Read and respond to any 

messages. During the installation, VMware Tools will be installed along with Ubuntu Linux OS. When the installation is 

finished, power off the new virtual machine and close VMware Workstation. Record your Ubuntu username and 

password below: 

Username: _________________________________  

Password: ______________________________ 

10. You may stay logged in to your Windows host for the next activity.  

  

http://www.ubuntu.com/


 

Activity 2-6: Moving an Existing Virtual Machine 

Time Required: 15 minutes 

Objective: Be able to move an existing VM to another host and add it the administrative console, and practice removing and 

adding tabs. 

Requirements: Completion of Activities 2-5 

Description: Now that you have created and tested the Ubuntu virtual machine on your VMware Workstation, you  next will 

need to move the machine to a production environment. In this activity you will simulate this process by moving your 

existing Ubuntu virtual machine to a different directory, removing the Ubuntu virtual machine from the administrative 

console, and then adding it back.  

1. If necessary, start your Windows host computer and log on with your assigned user-name and password. 

2. Open Windows Explorer, and create a directory named LinuxVMs on the root of the C drive. 

3. Move the folder named UbuntuVM-iii (where iii represents your initials) from your Documents\Virtual Machines folder 

to your new LinuxVMs folder, and then close Windows Explorer. 

4. If necessary, start VMware Workstation. Notice that the tab for your UbuntuVM-iii has been removed and that the 

UbuntuVM-iii machine in the Library pane has an “X” icon in it caused from moving the virtual machine files.  

5. In the Library pane, right-click your UbuntuVM-iii under My Computer, click Remove, and then click the 

Remove button from the VMware message box to confirm removing UbuntuVM-iii from the Library.  

NOTE: The following steps simulate the process you would use to add the Ubuntu virtual machine to another VMware 

Workstation host.  

6. From the Home tab, click the Open a Virtual Machine icon and navigate to the C:\LinuxVMs\UbuntuVM-iii folder. 

7. Click the UbuntuVM-iii configuration file (extension vmx), and then click Open to add the virtual machine to your 

administrative console. 

8. Start UbuntuVM by clicking the UbuntuVM-iii tab, and then clicking the Power on this virtual machine link. 

9. In the “This Virtual Machine may have been moved or copied” dialog box that opens, click the I moved it option button 

to retain the original virtual machine’s UUID code. (This step is important to maintain the machine’s MAC address on 

the network.) Then click OK to start UbuntuVM. 

10. If the Home tab is removed accidentally, you can add it back easily. To practice this, first, remove the Home tab by right-

clicking it and clicking Close Tab.  

11. Restore the Home tab by pointing to Tabs and then clicking Go to Home Tab. 

12. Shutdown the UbuntuVM by clicking the Shut Down Guest option from the power button located to the right of the Help 

menu option and then clicking the Shut down option from the VMware Workstation message box. 

13. This completes activity 2-6. You may leave VMware Workstation running and stay logged on for the next activity. 

  

file://192.168.1.9/LinuxVMs/UbuntuVM


Activity 2-7: Working with the Administrative Console Menus 

Time Required: 15 minutes 

Objective: Practice using menu options in the VMware Workstation administrative console. 

Requirements: Completion of Activities 2-6 

Description: In this activity, you practice using menu options in the VMware Workstation administrative console. 

1. If necessary, start VMware Workstation and click the UbuntuVM tab to make it active. 

2. Click Edit, Preferences from the menu to open the Preferences dialog box. Click the Updates link, and verify that the 

Software updates options are checked. Click the Automatically update VMware Tools on a virtual machine check box to 

enable automatically updating VMware Tools. 

3. Click the Hot Keys tab, and record the default hot key setting: 

____________________________________________________________________ 

4. Click the Workspace link, and record the default path to your virtual machine files: 

____________________________________________________________________ 

5. Click OK to close the Preferences dialog box. 

6. Click the VM menu and click the Power option. Record the available options in the space below: 

_______________________________________________________________________ 

7. Click the Start Up Guest option to start your UbuntuVM-iii virtual machine. 

8. Click View, Full Screen from the menu to switch the view of your virtual machine. 

9. Press Ctrl+Alt+Enter to switch back and forth between full screen and administrative console views. Notice that you can 

also use the Full Screen button on the toolbar to switch in and out of full screen mode. 

10.  Switch out of full screen mode. Click VM from the toolbar menu, point to Power, and record the options available for 

powering off or shutting down your Ubuntu VM: 

 _____________________________________________________________________ 

11. Click the Shut Down Guest option to shutdown the Ubuntu virtual machine. 

12. Click the VM menu and record all available power on options: 

_____________________________________________________________________ 

13. Click the Power on option to start your Ubuntu virtual machine. When you see the logon window asking for the 

username, click the VM menu and notice that all items are available. 

14. Suspend the virtual machine by clicking VM from the menu, pointing to Power, and clicking Suspend Guest. 

15. Click the VM menu and record the available Power options: 

_____________________________________________________________________ 

16. Click VM, point to Power, and record any power options that weren’t listed in Step 6: 

_____________________________________________________________________ 

17. Click the Resume Guest option and record the results on the following line. Do you think UbuntuVM started faster than 

it did in Step 7? If so, when you’re ending a virtual machine session, you might want to suspend the virtual machine 

instead of powering it off. 

_____________________________________________________________________ 

  



18. Click the Power Off option from the toolbar. You should see a warning message asking you to shut down the guest 

before powering off. This step prevents loss of data and possible corruption of programs or files on the virtual machine. 

If you’re logged off the guest OS, clicking OK and powering off the virtual machine should be safe. However, when 

possible, using the shutdown procedure is best. To shutdown your Ubuntu VM, click Cancel, click the arrow to the right 

of the Power icon, and then click Shut Down Guest. When asked to confirm this action, click the Shut Down button to 

power off the virtual machine. 

19. This completes the activities in this section. You may close VMware Workstation. 

 

  



Activity 2-8: Working with Menu Options 

Time Required: 15 minutes 

Objectives: Practice using options in the VM menu. 

Requirements: Completion of Activity 2-6 

Description: In this activity, you view the menu options that are available when a virtual machine is powered on and 

powered off. Before starting the activity ensure that all your VMs are powered off. 

1. If necessary, start VMware Workstation and click the Ubuntu tab to select this virtual machine.  

2. Click the VM menu and record the 4 options that are available when a VM is powered off. 

_______________________________________________________ 

3. With the VM menu still open, hover your cursor over the Power On option, and record the three power on options: 

_______________________________________________________ 

4. Click the Power On option to start your Ubuntu VM.  

5. When you see the Ubuntu logon window asking for the username, click the VM menu and notice that all options are now 

available. 

6. Suspend the virtual machine by clicking VM, pointing to Power, and clicking Suspend. 

7. Click the VM menu and verify that the options are the same as in when the VM was powered down in step 2. 

_______________________________________________________ 

8. Click VM from the menu, point to Power, and record the power options available when a VM is in a suspended state: 

_______________________________________________________ 

9. Click the Resume Guest option to resume the UbuntuVM virtual machine and record your results on the following line 

along with what you feel is an advantage of suspending a VM rather than powering it off.   

_______________________________________________________ 

10. Open the VM menu and click the Power Off option from the Power list. VMware will display a warning message 

informing you that you should shut down the guest operating system before powering off.  To prevent data loss, you 

should log off the guest OS before powering it off. Click the Cancel button and then power off the Ubuntu VM by using 

the Shut Down option from the Ubuntu system men. 

11. You may leave VMware Workstation session running for the next activity. 

  



Activity 2-9: Installing Windows Server 2008 on an Existing Virtual Machine 

Time Required: 30 minutes 

Objectives: Perform a manual installation of Windows Server 2008 R2 on an existing VM. 

Requirements: Completion of Activity 2-4 and the Windows Server 2008 ISO image file from chapter 1. 

Description: An instructor at Superior Technical College wants you to create a special virtual machine that has multiple disk 

partitions to be used in an operating systems class. Because VMware’s Easy Install option doesn’t have the partitioning 

options you need, you change settings for an existing virtual machine and then perform a manual installation of Windows 

Server 2008. 

1. Click the SRV2008R2 tab to make it active. 

2. Configure your virtual machine to use an ISO image file, as described previously in “Working with CD/DVD-ROM 

Drives and ISO Image Files section.” 

3. Next you set the virtual machine's BIOS to select the CD/DVD drive as the first boot device. Click VM on the 

menu, point to Power, and click Power On to Firmware. If necessary, click OK to bypass any informational 

messages and continue to the BIOS screen. Click in the BIOS screen to transfer keyboard control to the virtual 

machine. 

4. Use the arrow keys to select the Boot option, and check to see that the CD-ROM device is first in the boot sequence. 

If not, use the arrow keys to highlight the CD-ROM device, and then press the + key to move it to the top of the list. 

5. Use the arrow keys to select Exit, and then press Enter twice to save your changes and restart the virtual machine. 

The virtual machine now reads the setup program from the CD-ROM and starts the Windows Server 2008 

installation process. 

6. In the Install Windows screen, verify that the settings for the Installation language, time and currency format, and 

keyboard or input method are correct, and then click Next. 

7. Click the Install now button to display the Select the operating system you want to install window. Click the 

Windows Server 2008 R2 Enterprise (Full Installation) option and then click Next. Make sure you don't select 

the Sever Core version as this will not install the Graphical User Interface.) 

8. Review the license terms, click I accept the license terms check box, and then click Next. 

9. In the Which type of Installation do you want? window, click Custom (advanced) option to continue to the next 

window. 

10. Verify that Disk 0 Unallocated Space is selected in the Where do you want to Install Window? window and that 

you have a total size of 10ingoo0 GB from the virtual disk you created in Activity 2-4. Click Next to begin the 

installation process. This typically takes about 15 minutes, with at least one restart.  

11. When the installation is complete you will be asked to change password before logging in for the first time. Click 

OK to set the Administrator password. Enter the password in both the new password and Confirm password fields 

and click the right arrow. Note that your password must be at least 8 characters long and contain a combination of 

numbers and letters.  

12. Click OK to confirm the password change and display the Server 2008 desktop and Initial Configuration Tasks 

window. You can use this window to enter a product key and activate Server 2008 as well as perform a variety of 

configuration tasks including activating Windows by entering a product key and registering it with Microsoft. 

13. Click Close to close the Initial Configuration Tasks window and return to the desktop. 

14. Log off the Windows Server 2008 VM by clicking Start and then clicking the Log off button. 

15. Leave the Windows Server 2008 VM running for the next activity. 

  



Activity 2-10: Installing VMware Tools on a Windows Virtual Machine 

Time Required: 15 minutes 

Objectives: Install VMware Tools on an existing Windows 2008 Server  virtual machine. 

Requirements: Completion of Activity 2-9 

Description: In this activity, you learn how to install VMware Tools on your existing Windows Server 2008 virtual machine. 

1. If necessary, open the administrative console and start your SRV2008R2 virtual machine.  

2. Log on to Windows Server 2008 by clicking Send Ctrl+Alt+Del option from the VM menu and then entering your 

password. 

3. Press Ctrl+Alt to move the mouse pointer outside the virtual machine window. 

4. Click VM, Install VMware Tools from the menu. VMware may display a Software Updates dialog box informing 

you that VMware Workstation is connecting to the VMware server. If the update stalls, click Cancel to cancel the 

software update.  

5. If you see the AutoPlay dialog box, click the Run setup64.exe option to start the installation wizard and display the 

VMware Tools Welcome window.  

6. Click Next to display the Setup Type window.  

7. In the Setup type window, make sure the Typical option button is selected, and then click Next. 

8. In the Ready to Install the Program window, click Install. 

9. If you see warning messages about unsigned drivers, click Continue Anyway to continue. When the installation is 

completed, click Finish, and then click Yes to restart the virtual machine.  

10. After the installation is restarted, power off your virtual machine. You may leave VMware Workstation open for the 

next activity. 

  



Activity 2-11: Adding a Hard Drive to a Windows Virtual Machine 

Time Required: 15 minutes 

Objectives: Use the administrative console to add a hard drive to a virtual machine. 

Requirements: Completion of Activity 2-5 or Activity 2-9 

Description: An IT instructor wants her students to learn how to work with disk options in Windows Server 2008 and would 

like you to go through the process with her. In this activity, you test the process of adding a hard drive to your Windows 

Server 2008 VM and then format and access the new disk.  

1. Click the SRV2008R2 tab and verify that the virtual machine is powered off. 

2. Click VM, Settings from the menu and verify that the current Hard Disk is SCSI. 

3. In the Hardware tab, click the Add button to start the Add Hardware Wizard. 

4. In the Hardware Type window, click to select Hard Disk, if necessary, and then click Next. 

5. In the Select a Disk Type window, verify that SCSI is selected and that the mode is Persistent, and then click Next. 

6. In the Select a Disk window, verify that the Create a new virtual disk option button is selected, and then click 

Next. 

7. In the Specify Disk Capacity window, change that the maximum disk size of 40 GB to 10 GB, and be sure the 

Allocate all disk space now check box is not selected. Click to select the Store virtual disk as a single file option, 

and then click Next. 

8. In the Specify Disk File window, enter TempDisk2 for the virtual disk file, and then click Finish to place the file in 

your virtual machine folder. 

9. In the Virtual Machine Settings dialog box, click OK to save your changes. The next time you start this virtual 

machine, you can initialize and format the new hard disk.  

10. Power on your Windows Server 2008 virtual machine and log on as Administrator. 

11. Open Disk Management by clicking Start, right-clicking Computer, and clicking Manage. In the Computer 

Management window, click to expand Storage, and then click Disk Management. 

12. Right-click Disk 1 and click Online. Right-click Disk 1 a second time and click Initialize Disk. 

13. In the Initialize Disk window, verify that the Disk 1 check box is selected and that MBR is set as the partition style, 

and then click OK. By default the new disk will be initialized as a Basic disk. 

14. In the Disk Management window, convert the new hard drive to a dynamic disk by right-clicking Disk 1 in the right 

pane and clicking Convert to Dynamic Disk to display the Convert to Dynamic Disk dialog box. Verify that only 

Disk 1 is selected and then click OK to convert the disk to the Dynamic format.  

15. To create and format two 4 GB volumes on the new hard drive, right-click the Unallocated bar next to Disk 1 and 

click New Simple Volume. 

16. In the New Volume Wizard's welcome window, click Next.  

17. In the Specify Volume Size window, type 4000 in the Simple volume size in MB text box, and click Next.  

18. In the Assign Drive Letter or Path window, accept the default drive letter and click Next. 

19. In the Format Partition window, verify the Format this volume with the following settings option is selected and 

that NTFS is the file system. If necessary, click the Perform a quick format check box and then click Next. 

20. In the summary window, click Finish to create and format your new volume.  

21. Repeat Steps 14 through 19 to create a second volume with the remaining 4 GB of unallocated space and then close 

the Server Manager windows. 

22. Close the Server Manager window. 

23. Click Start, Computer, and verify that your new drives shows up in the Hard Disk Drives window.  

24. You may leave your Windows Server 2008 guest running and stay logged in for the next activity. 



Activity 2-12: Using Unity View to Share Applications with the Host 

Time Required: 15 minutes 

Objectives: Use Unity view in VMware Workstation to access virtual machine applications from the host computer. 

Requirements: Completion of Activities 2-11 

Description: Some programmers in the IT Department want to run applications installed on their virtual machines on their 

host computers, too. In this activity, you test the Unity view feature of VMware Workstation to learn more about it. 

1. If necessary, start your SRV2008R2 virtual machine and log in as Administrator. 

2. To enable Unity view, click View, Unity from the menu. Any applications running in the guest OS are placed in 

Unity mode automatically. 

3. A virtual Start menu appears above the Start menu in your host OS. If it isn’t visible, hover the mouse above the 

Start button on your host OS until the SRV2008R2 menu is displayed. 

4. Click SRV2008R2, point to Programs, point to Accessories, and click Notepad. 

5. Notepad appears in your host OS, but it’s actually running in the guest Windows 2008 OS. You can see this most 

clearly when you’re running two different OSs, such as the Windows Server 2008 guest OS on top of a Windows 7 

host, because the application uses the virtual machine’s OS interface (see Figure 2-13). A border also appears 

around the window, and a VMware icon is shown on the title bar. 

6. Enter some text into Notepad. 

7. From the Notepad menu bar, click Save As from the File menu. If necessary expand Computer and then save the 

document in the new E: drive you created in the previous activity.  

8. To exit Unity view, point to the Start Menu and then click Windows Server 2008R2 to display the pull down menu 

and then click the Exit Unity button. (You can’t access the virtual machine from the VMware Workstation console 

while in Unity view.) 

9. Exit Notepad and shut down your virtual machine running for the next activity. 

  



Activity 2-13: Working with Snapshot Manager 

Time Required: 15 minutes 

Objectives: Use Snapshot Manager to restore a virtual machine to previous saved states. 

Requirements: Completion of Activity 2-9 

Description: Follow these steps to create a snapshot tree of your Server 2008 R2 virtual machine, and then practice restoring 

your virtual machine to specific states: 

1. In the administrative console, click the SRV2008R2 tab to make this virtual machine active, if necessary. 

2. Click VM from the menu, point to Snapshot, and click Take Snapshot. Enter BaseMachine in the Name field and 

enter a brief description stating that this snapshot is the server immediately after Installation. Click the Take 

Snapshot button to save your snapshot. 

3. Start your Windows Server 2008 virtual machine and log on as administrator. 

4. Create a folder named WebBackup in to root of drive C on your Windows Server 2008 virtual machine file system. 

5. Copy all files from the C:\WINDOWS\Web\Wallpaper folder on your Windows Server 2008 virtual machine to 

the WebBackup folder. 

6. In the administrative console, click VM, point to Snapshot, and click Take Snapshot, and name the snapshot 

WebBackup. 

7. Create another folder named WinBackup in the C: drive root of your virtual machine file system. 

8. Select three files from the C:\Windows folder and copy them to the WinBackup folder. 

9. In the administrative console, click VM from the menu, point to Snapshot, and click Take Snapshot. Name the 

snapshot WinBackup. 

10. Click VM from the menu, point to Snapshot, and click Snapshot Manager. Record the items in your snapshot tree: 

_______________________________________________________ 

11. In Snapshot Manager, click BaseMachine and then click the Go To button. When you see the VMware Workstation 

message warning you that your current state will be lost, click Yes to restore the snapshot. Your virtual machine will 

be automatically powered off. 

12. Power on your Windows Server 2008 virtual machine and log on as the Administrator. 

13. Use Windows Explorer to verify that neither the WebBackup or WinBackup folder exists. Record your results: 

_______________________________________________________ 

_______________________________________________________ 

14. Repeat steps 11 - 13 to use Snapshot Manager to return to each snapshot, and check the status of the WebBackup 

and WinBackup folders. Record your results: 

_______________________________________________________ 

_______________________________________________________ 

15. When you’re finished, use Snapshot Manager to switch back to the BaseMachine snapshot. 

16. You may leave your Windows Server VM running for the next activity. 

  



Activity 2-14: Sharing Virtual Machine Files with Shared Folders 

Time Required: 15 minutes 

Objectives: Use shared folders to transfer files between a virtual machine and a host computer. 

Requirements: Completion of Activity 2-5; access to a classroom network containing a shared virtual machine directory. 

Description: The IT manager at Superior Technical College wants you to show employees how to use virtual machines to 

browse the Internet and download files. The files should then be scanned to check for viruses. After they’re verified as safe, 

the files can be transferred to the programmer’s host computer. In this activity, you prepare for this assignment by setting up 

shared folders on your host computer. 

1. In the administrative console, click the SRV2008R2 tab to make this virtual machine active, if necessary. 

2. Click VM, Settings from the menu, and then click the Options tab. 

3. Click the Shared Folders item on the left. Under Folder Sharing on the right, click the Always enabled option 

button to enable sharing, and then click the Add button to start the Add Shared Folder Wizard. 

4. In the wizard’s welcome window, click Next. 

5. In the Name the Shared Folder window, click the Browse button, select Desktop in the Browse for a host Folder 

dialog box and then click OK.  Leave the default name Desktop, and then click Next. 

6. In the Specify Shared Folder Attributes window, verify that the Enable this share check box is selected, and click 

Finish to complete the wizard. Click OK to close the Virtual Machine Settings window. 

7. If necessary start your Windows Server 2008 virtual machine and log on as Administrator. 

8. Click Start, right-click Network and click Properties to open the Network and Sharing Center. Verify that Private 

network is displayed to the right of the home icon.  

9. Click the Change advanced sharing settings link on the left side of the window and, if necessary, click the arrow 

to expand the Home or Work heading. 

10. Under the Home or Work heading, click to select Turn on network discovery and Turn on file and printer 

sharing options, and then click Save changes. 

11. Close the Network and Sharing Center window. 

12. Open a computer window by clicking Start, Computer, right-click a blank area under the Devices section and then 

click the Add a network location option to open the Welcome to the Add Network Location wizard. Click Next to 

start the wizard. 

13. Click to select the Choose a custom network location option and click Next to display the Specify the location of 

your Website window. 

14. Click the Browse button and then click to expand the vmware-host server.  Click Desktop and then click OK 

to insert the \\vmware-host\Shared Folders\Desktop path in the network address dialog box. 

15. Click Next to display the What do you want to name this location? window.  

16. Accept the default display name of Desktop and then click Next. 

17. Click Finish to complete the wizard and display the newly created share. Close the Desktop share window and 

notice that the Desktop share now appears under the Network Location heading in the Computer window. You can 

now view files on your host computer’s desktop and copy files between it and the virtual machine with your new 

shared folder. 

18. Power off your Windows Server 2008 virtual machine for the next activity. 

  



Activity 2-15: Sharing Virtual Machine Files with a Mapped Virtual Disk 

Time Required: 15 minutes 

Objectives: Use the Mapped Virtual Disk feature to access virtual disk files when the virtual machine is powered down. 

Requirements: Completion of Activity 2-5; access to a classroom network containing a shared virtual machine directory or 

the sample virtual machine files downloaded from this book’s Web site. 

Description: Sometimes you need to be able to access a virtual disk without powering on the virtual machine. In this activity, 

you learn how to access SRV2008R2's virtual disk while it’s powered down. 

1. If necessary, power off your Windows Server 2008 virtual machine, and then click the SRV2008R2 tab to make it 

active. 

2. Click File, Map Virtual Disks from the menu to open the Map or Disconnect Virtual Disks dialog box. 

3. Click the Map button, and in the Map Virtual Disk dialog box, click the Browse button and navigate to the folder 

containing your Windows Server 2008 virtual machine files. 

4. Click the virtual disk file (.vmdk extension) corresponding to the virtual disk you want to map the drive to, and then 

click Open. 

5. In the Map to section, change the drive letter to the one you want the host computer to use when accessing this 

virtual disk. 

6. Verify that the Open drive in Windows Explorer after mapping option is selected and then click OK to complete 

the drive mapping. You can now copy files from the virtual hard disk by using a physical drive letter on your host 

computer.  

7. Before you can start the virtual machine, close any open folders using your mapped drive, and then click File, Map 

or Disconnect Virtual Disks from the menu to disconnect the drive mapping. The virtual machine can’t start if its 

disk is in use by the host computer.  

8. Leave VMware Workstation running for the next activity. 

  



Activity 2-16: Working with Virtual Network Options 

Time Required: 15 minutes 

Objectives: Determine IP addresses of virtual machines and verify communication between them and the host computer. 

Requirements: Completion of Activity 2-11 

Description: In this project, you test communication between your virtual machines and the host computer. 

1. First, you need to verify that both your Ubuntu and Windows 2008 virtual machines are set to host-only. To do this, 

click each virtual machine’s tab and check the Network Adapter setting in the Devices pane. If the Network 

Adapter is not set to Host-only, click Network Adapter, click the Host-only option button, and then click OK. 

2. Open a command prompt window on your host computer. Type ipconfig /all and press Enter. Record the IP 

addresses for VMnet1 and VMnet8: 

_______________________________________________________ 

3. If necessary, start the UbuntuVM and SRV2008R2 virtual machines. 

4. Open a command prompt window on your Windows Server 2008 virtual machine, type ipconfig /all, and press 

Enter. Record the IP address assigned to the Ethernet adapter Local Area Connection: 

_______________________________________________________ 

5. Verify that you can communicate with your host computer by typing ping IPaddress (replacing IPaddress with the 

one you recorded in Step 2 for VMnet1) and pressing Enter. 

NOTE:  Four Ping requests are sent to the host computer. If they’re successful, replies are reported with how long the host 

took to respond. If the virtual machine is unable to contact the host computer, you get a "Destination host unreachable" 

message. 

6. Open a terminal window on the UbuntuVM virtual machine. Type ifconfig and press Enter to determine this virtual 

machine’s IP address. 

7. Verify communication between UbuntuVM and the host computer by typing ping IPaddress (replacing IPaddress 

with the one you recorded in Step 2 for VMnet1) and pressing Enter. 

8. From the Windows Server 2008 virtual machine, verify that you can communicate with UbuntuVM by typing ping 

IPaddress (replacing IPaddress with the IP address of UbuntuVM) and pressing Enter. 

9. Verify that your Windows Server 2008 machine is the active virtual machine and the click VM and click Settings to 

display the Hardware settings windows. Use the procedure In step 1 to change the Network Adapter setting for your 

Windows Server 2008 virtual machine to NAT (used to share the host’s IP address) and then click OK to save the 

setting and return to the Windows Server 2008 desktop. 

10. If necessary, open a command prompt window. In the command prompt window, type ipconfig /release and press 

Enter. Then type ipconfig /renew and press Enter to force your virtual machine to release its old IP address and 

request a new one. 

11. Verify that you can communicate with the host computer by typing ping IPaddress (substituting the IP address you 

recorded in Step 2 for VMnet8) and pressing Enter. If your host computer is connected to the Internet, you should 

now be able to use Internet Explorer to access the Internet from your Windows Server 2008 desktop. Document your 

results: 

_______________________________________________________ 

_______________________________________________________ 

12. Close all open command prompt windows and power off both virtual machines. Leave VMware Workstation 

running for the next activity. 

  



Activity 2-17: Cloning and Sharing the Ubuntu VM Virtual Machine 

Time Required: 15 minutes 

Objectives: Create a clone of an existing virtual machine. 

Requirements: Completion of Activity 2-5; access to a classroom network. 

Description: The IT instructors at Superior Technical College want to create a shared Ubuntu virtual machine for use by all 

students in the Linux class. In this activity you are to test the process of using the VMware Workstation sharing feature to 

create and share a cloned copy of your Ubuntu virtual machine. 

1. If necessary, shut down the parent virtual machine, UbuntuVM. 

2. You can share a VM by simply dragging it from the My Computer heading and dropping it on the Shared VMs 

heading. To share your Ubuntu VM, click and drag your Ubuntu VM from under My Computer heading and then 

drop it onto the Shared VMs heading to start the Share VM Wizard. 

3. When you see the Welcome to the Share VM Wizard window, click Next to display the Select Transfer Type 

window. Under the How would you like to transfer the virtual machine to the "Shared Virtual Machines directory?" 

heading, click to select the Make a full clone of the virtual machine option and record the path to the shared 

virtual machine folder on the line below: 

_______________________________________________________ 

4. In the Shared Virtual Machine Name text box, add the word "-Shared" to the default name. 

5. Click Finish to perform the cloning and registering processes and then click Close to exit the wizard. The shared 

clone is now available as a tab in the administrative console. 

6. Power on the clone and log on. This shared VM will now be available from VMware Workstation running on other 

computers. 

7. Power off the clone and exit VMware Workstation. 

  



Activity 2-18: Importing a Physical Computer as a Virtual Machine 

Note: This activity requires downloading and installing VMware Converter. The steps in this 

activity may vary slightly based on the version of the VMware Converter being used.  

Time Required: Over one hour. 

Objectives: Use VMware Converter to create a virtual machine from a physical computer. 

Requirements: Completion of Activity 2-9 

Description: Your IT manager wants to convert a Windows server to a virtual machine. As practice, you want to convert 

your workstation first. In this activity, you learn how to create a virtual machine from a physical computer. 

1. Determine which physical computer you will be used to create the virtual machine.  

2. If necessary, download the standalone version of VCenter Converter to a directory on the computer you will convert. 

3. If necessary, perform the instructions in this step to install VCenter Converter. Double-click the installation file, 

click Next in the Welcome window, and then click I Agree and click Next to start the installation wizard. Click 

Next to select the default for Destination Folder and Local Installation as the Setup Type. Click Install to start the 

installation process. When the Installation Completed window is displayed, click to remove the check from the Run 

Client now option and then click Finish to close the window.  

4. Create a folder using your Initials on the physical computer for storing the virtual machine files created from the 

physical computer you’re importing. 

5. Start VCenter Converter, by clicking Start, All Programs, VMware, VMware Center Converter Standalone Client.  

Click the Convert Machine option to display the Conversion window. 

6. In the Source window, accept the default Powered-on machine in the Select source type textbox.  

7. In the Specify the powered-on machine frame, click the This local machine option button and then click View 

source details link to view a windows showing the physical machine's specifications. After viewing the 

information, click Close and then click Next to display the Destination System window. 

8. Click the down arrow to the right of the Select destination type textbox and then click to select the VMware 

Workstation or other VMware virtual machine option.  

9. In the Select VMware Product, select the latest version of VMware Workstation. 

10. In the Virtual machine details frame, enter a name for the virtual machine that includes your initials and then use the 

Browse button to select the folder you created in step 4. Click Next to display the Options window.  

11. In the Data to copy option, if necessary, use the Edit link and select only the C: physical drive to include in the 

virtual machine image file. 

12. Click the Edit link in Advanced options, click the Post-conversion tab, and then click to select the Install VMware 

tools on the destination virtual machine option. Click Next to display Summary window. 

13. Verify your options and then click Finish to start the process. This may take over an hour depending on the size of 

the physical machine. During the cloning process, a log of activities will be displayed in the lower right-hand 

window. 

14. After the virtual machine is created, verify the Log highlights windows to confirm the process was successful 

completed and then click File, Exit to close the VMware Center Converter window. 

15. Copy the virtual machine folder to your host computer and then follow the instructions in this chapter to add the 

virtual machine to your administrative console. )The new virtual machine will use the same license as the physical 

computer. If you do not have a volume license on the original computer, you will need to power it down prior to 

starting the virtual machine. If you have a volume license key, you can start this virtual machine without triggering a 

licensing error.) 

16. If possible, start your cloned virtual machine and verify that your new virtual machine can access the Internet.  

17. Power down the virtual machine. As this is the last activity in this chapter, you may wish to exit VMware 

Workstation, close any open windows, and log off your host computer. 

 


